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Before You Begin

About This Book
This License Utility Guide describes the FactorySuite 2000 (Version 7.1) 
licensing strategy and explains how to use the License Utility to install license 
files and browse valid license files on the network.
License Utility Guide
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Introduction

This chapter describes the FactorySuite 2000 (Version 7.1) licensing strategy.

Contents
� Overview of FactorySuite 2000 Licensing

� Upgrading to FactorySuite 2000 Licensing

� Wonderware's Anti-Piracy Program

Overview of FactorySuite 2000 Licensing
The Wonderware FactorySuite 2000 release consists of multiple software 
components (applications). The Wonderware License Agreement grants you 
the right to use and display the software on a single computer at a single 
address location. In addition, Wonderware provides several types of 
enforcement mechanisms to license and enable specific software programs. 
The goal of FactorySuite 2000 licensing is to further simplify how licensing is 
implemented for Wonderware products. The FactorySuite license management 
system is designed to work with or without a hardware key (dongle). Upon 
validation of the licensing information, the appropriate FactorySuite 2000 
software component will be activated. 

Proper Use of Licensing
Purchasers of software do not actually own the intellectual property of the 
software. Instead, they are buying the right to use the software according to the 
terms and conditions of the license agreement and the license enforcement 
mechanism. Wonderware software is licensed using a "soft" license, a "soft" 
license locked to a hardware key (dongle), or a paper license. All legal 
software is supplied with a license. 

To be certain you are legally entitled to use the software, please examine the 
license. There are three "tokens" of the right to use the software: the license 
file, the license file locked to a dongle, or the paper grant of license. 
License Utility Guide
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The license file is typically delivered on a 3-1/2" floppy disk with a 
Wonderware label. The label displays a teal-colored FS2000 logo in the upper 
left corner and contains the following information:  Product Description, Part 
Number, Serial Number, Version Number, and User Company Name. Also, 
you should not have any licenses with the same identical serial number 
installed on multiple PCs. Licenses with the same serial number installed on 
multiple PCs is an indication of illegal copies. The exception to this is special 
Site Licensed Products.

A paper grant of license is used for the following FactorySuite components: 
FactoryFocus Site, IndustrialSQL CAL, IndustrialSQL Internet Connector, 
Scout, Crystal Reports and the FactorySuite Toolkit. Paper licenses are also 
used for Microsoft products that are embedded with Wonderware components, 
such as Microsoft SQL Server and Microsoft Client Access License.

Wonderware Corporation is a group of professionals providing software to 
other professionals. You expect great software from us, and we expect you to 
use the software in accordance with the legal implications of licensing. This 
business relationship between software supplier and software user enables 
Wonderware to continue providing software to help meet your needs.

The term "software piracy" has been used to describe illegal deployment of 
software. A more descriptive term would be "theft." Wonderware asks you to 
only use software in the manner in which it is licensed and to set a high 
licensing compliance standard for other professionals in our industry. Do not 
steal software. 

For more information, see "Wonderware's Anti-Piracy Program" on page 12.

WWSUITE.LIC License File
For FactorySuite 2000, licensing is enforced for all Wonderware products 
through the use of a single license file, WWSUITE.LIC. When you buy a 
Wonderware product, customer information, product data and functionality, the 
serial number, and so on is included in this license file.

The WWSUITE.LIC license file is distributed on a floppy diskette. You must 
install the license file using the FactorySuite 2000 License Utility. This utility 
can also be used to view the details of the license file.

In order to view or manage license files, you must have administrative rights 
for the folder(s) in which the license files reside. For example, if you want to 
install a license file in a folder on a network computer, your network user 
account must have administrative rights for that folder. This provides a level of 
security since only the network administrator or someone with similar rights 
can manage FactorySuite licensing. 

Feature Lines and License Components
A feature line represents enabled functionality for a Wonderware software 
component. For example, the INBATCH_DEVELOPMENT_CLIENT feature 
line enables InBatch remote development functionality.

A FactorySuite license component is a set of one or more feature lines that are 
licensed for use on a computer.  Each FactorySuite license component is 
assigned a unique part number.
License Utility Guide
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Once you have installed the WWSUITE.LIC license file, you can move license 
components from one computer to another using the License Utility.

Note  After installation, the source license file (the one on the floppy) retains 
its license components. After a license component move, the source license file 
will no longer contain the license component. For example, if you move 
License Component X from Computer A to Computer B, Computer A will lose 
the license component, while Computer B will gain it.

Installing Multiple License Components on a 
Single Computer

The License Utility allows you to add different license components to a license 
file, enabling multiple products with different features for a single computer. 
The License Utility equates a product as a license component line with its 
associated feature lines in the license file.

For example, you buy InTouch and install its WWSUITE.LIC license file. 
Later, you buy InControl and install its WWSUITE.LIC license file on the 
same computer. The License Utility will append the contents of the InControl 
WWSUITE.LIC license file to the existing InTouch WWSUITE.LIC license 
file. This would allow you to run both products on the single computer. If you 
later wanted to run the products on separate computers, you would delete the 
InControl license component and then install the InControl license file on 
another computer.

If you attempt to install a license component to a license file that already 
contains the same license component, then the License Utility will ask whether 
you wish to overwrite or abort the installation.

There are some instances in which it is possible to have multiple license 
components that contain the same feature line. In these cases, the functionality 
for the first feature line listed in the license file is used.

For example, you buy FactorySuite and install the license file that enables it. 
You then buy a later version of InTouch (which supports more tags) and, using 
the License Utility, append its license file to your existing license file. You now 
have a license that contains two InTouch features lines: one for FactorySuite 
and one for the later version of InTouch. When InTouch is started, it will read 
the InTouch feature line for the FactorySuite to determine functionality, since it 
is listed first. To correct this, delete or move the FactorySuite license file, 
install the newer InTouch license file, and then append the FactorySuite license 
file to the InTouch license file. 

Serial Numbers
A serial number is a unique number that is associated with the purchase of a 
license by a customer. Each WWSUITE.LIC license file that is distributed on 
floppy disk includes this serial number. The license file serial number is 
located on the label of the license floppy disk. You can also view the serial 
number using the License Utility.
License Utility Guide
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Products that are licensed via a paper license do not have a soft license file. 
These products include Scout, Crystal Reports, IndustrialSQL Server Client 
Access License (CAL), IndustrialSQL Internet Connector, FactorySuite 
Toolkit, and the FactoryFocus Site (has both a soft license file and a paper Site 
license); as well as Microsoft Internet Connector and Microsoft SQL Server, 
which have Microsoft paper licensing.

Version Enforcement
All software components in FactorySuite 2000/7.1 will be version 7.1, except 
for some of the I/O Servers.  The version number can be viewed using the 
License Utility and is listed on label of the floppy diskette on which the 
FactorySuite 2000 license file is distributed.

When an installed FactorySuite software component starts up, the license file 
will be checked to ensure that the current version is licensed for use. If the 
software component version and the licensed version are not the same, the 
software component will default to either an invalid or absent license mode.

Hardware Key Support
The SuperPro type hardware keys (dongles) will be supported for FactorySuite 
2000. The single license file that you will receive with FactorySuite 2000 will 
be "locked," or permanently associated with, the hardware key serial number. 
All hardware keys issued by Wonderware have a unique serial number. The 
serial number for the hardware key is matched to the license file with an 
authentication algorithm. Both the license file and the hardware key must be 
installed on the same computer in order to run the FactorySuite software 
component. Simply install the FactorySuite component, then the license file. 
Attach the hardware key to the computer's parallel port. 

Software Behavior For Various License 
Situations

The various licensing situations and the expected software component 
behavior are identified in the following table:

Mode Software Component Behavior
Valid license Normal operations as constrained by 

license.
Invalid or absent license Enters a demonstration mode, if applicable. 

The demonstration mode may consist of a 
subset of product functionality. The user 
will be notified upon start up that a license 
was not detected, and that the system is 
running in demonstration mode. The 
demonstration mode will expire after 2 
hours (120 minutes).
License Utility Guide
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Note  To install ActiveX controls in InTouch, you must have a valid license 
file installed. 

The following table summarizes software component behavior in each of these 
licensing situations:

*Will only run in 24-hour demo mode if a license file was never installed. The 
24-hour demo mode includes full operation with some I/O restrictions. The 7-
day demo mode is more like a restricted mode. It does not allow the program to 
be edited, but will continue to run until the user resolves the license issues.

Upgrading to FactorySuite 2000 Licensing
Wonderware maintains an audit trail of all license file upgrades, and creates 
your FactorySuite 2000 license file (WWSUITE.LIC) accordingly. 

Upgrading from a Hardware Key
Licensing was enforced by the use of a hardware key, or dongle, for all 
versions of Wonderware products previous to FactorySuite 1000 and as an 
optional licensing strategy for FactorySuite 1000. If you have upgraded from a 
Wonderware product that used a hardware key, the single license file that you 
will receive with FactorySuite 2000 will be "locked," or permanently 
associated with, your existing hardware key serial number. 

License expiration Continue normal runtime operations, 
except for IndustrialSQL Server and 
InControl. IndustrialSQL Server will shut 
down in an orderly fashion, stopping and 
disabling the Microsoft SQL Server, if it 
was installed during the IndustrialSQL 
Server installation.

License failure (a valid license 
becomes invalid during 
runtime)

Continue normal runtime operations. When 
the system is restarted, it will operate in the 
"Invalid or Absent License" mode.

Software Component
Invalid or Absent 
License License Expiration License Failure

InBatch Will not start Normal operations Normal operations
InControl* 24-hour demo mode 7-day demo mode 7-day demo mode
IndustrialSQL Server 120-minute demo mode Shuts down, stopping 

and disabling MS SQL 
Server

Normal operations

InTouch 120-minute demo mode Normal operations Normal operations
InTrack Will not start Normal operations Normal operations
I/O Servers 120-minute demo mode Normal operations Normal operations

Mode Software Component Behavior
License Utility Guide
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Upgrading from FactorySuite 1000
For FactorySuite 1000, each product's licensing information was located in a 
separate product .LIC file. For example, INTOUCH.LIC, INTRACKD.LIC, 
IB_SERV.LIC, and so on. When a FactorySuite 1000 license file is upgraded to 
support FactorySuite 2000, a new single FactorySuite 2000 license file 
(WWSUITE.LIC) is created at Wonderware and shipped to the end user. 

The separate FactorySuite 1000 license files are translated to feature lines 
within the WWSUITE.LIC license file. This includes all customer information, 
product data and functionality, customer types, hardware key serial numbers, 
license file expiration dates for consignment systems, and so on. 

The serial number for each FactorySuite 1000 license file is consolidated into a 
single FactorySuite 2000 serial number for the WWSUITE.LIC license file. 

Comment lines for each FactorySuite 1000 license file are merged into a single 
comment line in the WWSUITE.LIC license file. FactorySuite 1000 comment 
lines include information for the part description, software component 
functionality, part number, and serial number. The FactorySuite 2000 license 
component comment line includes the part description, features enabled, a 
single part number, and serial number. 

Note  If you upgrade from an 32K tag InTouch system for FactorySuite 1000 
(both development and runtime) the license file will be modified to support the 
full 60K tag system. 

Wonderware's Anti-Piracy Program
The Business Software Alliance is a global organization with the primary 
purpose of investigating and assisting in the prosecution of software pirates. 
Many software companies are members including Microsoft, AutoDesk, and 
Novell. According to the Business Software Alliance, software piracy accounts 
for more than $12.8 billion in lost revenues annually. Copying software is not 
only illegal at both the civil and criminal level, it is also costly!  

To address this problem, Wonderware has established an Anti-Piracy Program 
to ensure that Wonderware and its sales channel receive appropriate revenues 
from the sale and use of Wonderware products.  The Wonderware Anti-
Piracy Program consists of anti-piracy educational seminars, an ongoing 
study of how our software products are being used in the industry, a legal 
department dedicated to prosecuting illegal use of software, a financial reward 
to helpful individuals who identify software piracy that leads to prosecution 
and/or fines, and several ways to contact Wonderware about suspected 
software piracy.  

If you know of, or believe you know of an organization or an individual 
committing software piracy, please let us know. With this information we can 
investigate and determine whether the case in question is indeed a case of 
piracy and determine what appropriate legal actions need to be taken.
License Utility Guide
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If you would like more information about Wonderware's Anti-Piracy Program 
see our Web site listed below, if you would like to contact Wonderware 
Corporation concerning a possible case of software piracy, you can reach us 
though our Web site:

Phone: 949-450-5058 (Confidential piracy hotline. This phone number is 
located in the United States.)

Email: piracy@wonderware.com
Web: www.wonderware.com  (Use our web site Search field by typing 

in the word "piracy," or click on Contact Us.)
License Utility Guide
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Using the License Utility

You can use the License Utility to install license files and browse valid license 
files on the network.

Contents
� About the License Utility

� Starting the License Utility

� Saving License File Information to a .CSV File

� Viewing License Information in the .CSV File

� Searching by Name

� Installing a License

� Browsing License Information

� Moving or Deleting a License File

� Moving or Deleting a License Component

� Reading the License File from a Floppy Drive

About the License Utility
The License Utility is used to track (locate and view license files both on the 
local computer and remote computers) and count license files. The License 
Utility is also used to install license files locally and remotely and to move 
license components from one license file to another.

License installation and configuration should only be done by a network 
administrator. You can only view and/or move licenses that are located in 
folders for which you have administrative rights. Using the License Utility, you 
can:

� Track FactorySuite 2000 licenses. 

� From a remote location, inspect the network for license files and indicate 
the locations and total count of each license for an installed product. 

� Move license files from one computer to another.

� Move one or more license components in a license file to another license 
file.
License Utility Guide
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� Install license files. 

Note  The License Utility that is shipped with FactorySuite 2000 can only 
manage licenses for FactorySuite 2000 software components; use the 
FactorySuite 1000 License Viewer to track FactorySuite 1000 licenses.

Starting the License Utility
To start the License Utility

1. Install the product(s) from the FactorySuite CD or over the network.

2. Start the License Utility by doing any of the following:

� Insert the license diskette into your floppy drive. On the Start menu 
on the Windows Taskbar, select Run. In the dialog box, type 
a:\install.

� On the Start menu on the Windows Taskbar, point to Programs, 
Wonderware FactorySuite, then to Common, and then select 
License Viewer.

� Launch the License Utility from any FactorySuite application by 
selecting the About command on the Help menu and then clicking 
View License.

3. The License Utility main window appears.

To exit the License Utility, click Exit on the File menu.

License Components Window

Results/Feature Line Window

Browser

Status Bar

Toolbar
License Utility Guide
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Toolbar
The main toolbar appears beneath the menu bar. Use the tools on the main 
toolbar to execute commonly used menu commands. 

The tools are described in the table below: 

Browser
The browser appears at the left side of the License Utility. You can navigate in 
the browser as you would any typical Windows based browsing application. 
Upon program initialization, the browser will display the local machine, as 
well as the path to the local license file, if found.

License Components Window
The License Components window lists the license components for all license 
files found on the computers that currently appear in the browser. The License 
Components window has five columns, which are described in the following 
table.

Button Used To
Install a license file.

Delete a license file.

Clear the browser of searched computers.

Search a computer for license files.

Search the network for computers with license files.

Delete a selected license component.

Display the online Help.

Column Description
Count Enumeration of the license components found.
Component Name Name of the license component.
Location Path to the license file using the Universal Naming 

Convention (UNC) format.
License Utility Guide



18 Chapter 2
If you select a license component in the License Components window, all of 
the feature lines for that license component will be displayed in the Results 
window. Select the license component by clicking on the Count column.

Results Window
The Results window displays the feature lines for the license component that 
is selected in the License Components window. This area also displays any 
error messages.

Status Bar
The status bar allows you to view the status of the connection.

Saving License File Information to a .CSV File
You can use the License Utility to export license file information to a .CSV 
(comma separated values) formatted file. This allows you to collect license 
information from non-networked computers in your plant. You can then view 
the .CSV information with a single application, such as Microsoft Excel. The 
.CSV file is generated from the currently installed license file on the computer.

When license file information is exported to a .CSV file, the exporter writes 
consecutive lines for the current licenses in the license file. The exporter does 
not overwrite an existing .CSV file. It only appends to it. When you select an 
existing .CSV file to save the license information to, a blank row is 
automatically inserted and then the new license information is appended. The 
exporter does not check for duplicate license information when it appends new 
information to an existing file. Therefore, you must visually distinguish 
duplicate license information when viewing the .CSV file in an application 
such as Microsoft Excel.

Note  In order to browse, manage, or install license files, you must first 
establish connections to the computers on the network that use license files. 

Part Number Part number for the FactorySuite license component.
Serial Number Serial number as read from the license file.

Column Description
License Utility Guide
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To save license file information to a .CSV file:

1. On the Options menu, select Export to .CSV File. The Enter the File 
name dialog box appears.

2. Locate the directory in which you want to save the .CSV file.

3. In the File name box, type a name for the new .CSV file or, select an 
existing .CSV file. 

4. Click Save.

Note  If you attempt to create a .CSV file in a location for which you do 
not have access or write privileges (for example, a write-protected floppy 
disk in your A:\ drive), a warning message appears. 

5. If an existing file is selected, the File Exists message box appears.

6. Select Yes to append the information at the end of the existing file or No to 
cancel the operation and return to the License Viewer main window.

Viewing License Information in the .CSV File
You can view the information saved in a .CSV file by using any text editor 
program. If you are using a text editor such as Notepad, each item of license 
information is separated by a comma. If you open the .CSV file in Microsoft 
Excel, each item is displayed in a separate column. Using Microsoft Excel to 
view your license information is recommended. 
License Utility Guide
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Each license information item is described in the following table:

Searching by Name
If you know that a license file exists on a particular computer, you can search 
by name for that computer to see if it is available. 

Item Description
Node Name Computer name where the license file is installed.
User Name Current user logged on the node.
Description Description specified in "#" line at the beginning of each 

license.
Part Number Part Number specified in "#" line at the beginning of 

each license.
License File Serial 
Number

License File Serial Number specified in "#" line at the 
beginning of each license.

Version Number Version Number specified in "#" line at the beginning of 
each license, this is the version number of the license 
file.

Expiration Date Expiration Date as specified in the FEATURE_LINE for 
each license. If the expiration date is 1-jan-00 the value 
in this column will say "No Expiration", otherwise it will 
display the date as specified in the license file. 

Hardware Key 
Serial Number

The HWKey Serial Number column will display a value 
if the FEATURE HOSTID is mapped to a hardware key. 
Otherwise, it will be blank. The value displayed is the 
decimal equivalent of the Hex value specified in 
HOSTID for each license.

Name of Licensee The name of the customer who is authorized to use this 
license file.

Not For Resale This indicates whether this license file is available for 
resale. Generally, Consignment licenses are Not For 
Resale. This column remains blank if the field is not 
valid for this license.
License Utility Guide
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To connect to a computer by name:

1. On the Search menu, select Computer or, click the  tool. The 
Search Computer for License File dialog box appears.

2. In the Domain box, type the name of the domain in which the computer 
resides.

3. In the Computer box, type the name of the computer on which you want 
to search for a license file.

4. Click OK.

If a license file is found on the computer, the computer will now be listed 
in the browser:

Searching the Entire Network
If you don't know which computers have license files, you can search the entire 
network and build a list that will be displayed in the browser.
License Utility Guide
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To search the network for computers with license files:

1. On the Search menu, select Network or, click the  tool. The Search 
Network dialog box appears.

2. In the Available Network Resources window, highlight the name of the 
domain for which you want to search for computers having license files.
License Utility Guide
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3. Click the   button to display all of the computers on that domain 
in the Search Criteria window. The computers in the Search Criteria list 
are computers that will be searched for license files. For example:

4. To exclude a computer from the search, select the computer in the Search 

Criteria window and click the  button.

5. To clear the Search Criteria window, click Reset All.

6. To start searching for computers that have license files, click Search.

For a remote computer, the License Utility determines if it has a valid 
license file installed by examining the Wonderware$ share. For the local 
computer, the License Utility determines if it has a valid license file by 
reading the license path in the Registry.

A message will be displayed along the bottom of the dialog box that 
indicates the status of the search (for example: 2 out of 147 searched).

7. To stop the search at any time, click Stop.

When the search is complete, all computers that have license files installed 
will be listed in the browser of the License Utility. 

8. To clear the browser of any searched computers, on the File menu, select 
Clear Tree.
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Installing a License
Use the License Utility to select the license you want to install from the source 
location, which can be either a floppy drive or a network folder. If a license file 
does not already exist on the destination computer, one will be created that will 
be identical to the license file from the source location. If a license file already 
exists, you have a choice to either overwrite or append the new license file's 
component and feature line information to the existing license file. The license 
file in the source location will not be deleted at the end of the install. 

To install a license file:

1. On the File menu, select Install License File or click the  tool. The 
Choose a License File to Install dialog box appears.

2. Locate and select the license file (.LIC) you want to install and then, click 
Open. The Destination Computer for Installation dialog box appears.

3. In the Domain box, type the name of the domain in which the computer 
resides.

4. In the Computer box, type the name of the computer on which you want 
to install the license file.

5. Click OK.
License Utility Guide
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6. If an existing license file exists, the Installing a License File dialog box 
appears.

7. To overwrite the license file, click Overwrite.

8. To append the new license file information to the existing license, click 
Append.

The results of the installation will be displayed in the Results window.

Browsing License Information
You can browse licensing information for any computer that is displayed in the 
License Utility browser. 
License Utility Guide
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To browse license information:

1. In the License Components window, locate the name of the computer in 
the Location column.

For information on the columns in the License Components window, see 
"License Components Window" on page 17.

2. Select the license component by clicking the Count column.

The summarized feature lines for that license component will appear in the 
Results window.

3. To view detailed feature lines for a license component, on the Options 
menu, select Detailed Feature Lines. Select Detailed Feature Lines a 
second time to switch back to the summarized view.

4. Repeat steps 1 through 3 for any additional license component from the 
same location.

Moving or Deleting a License File
You can move an entire license file from one network computer to another. The 
License Utility only supports the move operation; you cannot copy a license 
file or any license component of a license file from one computer to 
another. 

To move a license file:

1. In the License Utility browser, select the license file.

2. Drag-and-drop it into the destination computer.

You will be prompted to verify the move.

3. To move the license file, click Yes. Otherwise, click No.
License Utility Guide
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4. The results of the move will be displayed in the Results window.

To delete a license file:

1. In the License Utility browser, select the license file.

2. On the File menu, select Delete License File.

Moving or Deleting a License Component
You can move a single license component in a license file from one network 
computer to another. The License Utility only supports the move operation; 
you cannot copy a license file or any license component from one share to 
another. 

To move a license component:

1. In the License Components window, select the license component.

2. Drag-and-drop it into the destination computer.

3. You will be prompted to verify the move.

4. To move the license file, click Yes. Otherwise, click No.

5. The results of the move will be displayed in the Results window.

To delete a license component:

1. In the License Utility browser, select the license component or, click the 

  tool.

2. On the Components menu, select Delete.

Reading the License File from a Floppy Drive
If you are running a Wonderware product, you can specify to have the product 
first look for a valid license file on a diskette in the computer's floppy drive, 
instead of on the hard drive. You can also use this feature for any third-party 
product that incorporates the latest version of the Wonderware License 
Manager. 

One example of how this feature can be used is for ease in application 
development updates. An application developer can enable development 
functionality with a license file residing on a floppy diskette, make changes to 
the application, and then return the application to using the normal runtime 
license file. 

Any license file currently residing on the computer's hard drive will remain 
intact. If you specify to read the license file from a floppy drive and a diskette 
is not in the drive, the license file on the hard drive will automatically be used 
instead. The only exception to this is for I/O Servers. 

For more information, see "Floppy Drive Option and I/O Servers" on page 28.
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Note  The Wonderware License Manager attempts to read a specific path to 
the license file on the floppy diskette (x:\LICENSES\WWSUITE.LIC, where x 
is the drive letter). If you change this path on the diskette, the License Manager 
will not be able to find the file.

To enable reading of the license file from the floppy drive:

1. On the Options menu, select Floppy License. The License Utility dialog 
box appears.

2. To use a license file on a floppy drive, select the appropriate drive letter. 

3. To use the license file on the hard drive, select None.

4. Click OK.

Floppy Drive Option and I/O Servers
If you specify to read the license file from a floppy drive, and a diskette is not 
in the drive, an "Abort, Retry or Ignore?" dialog box will appear when the I/O 
Server starts up. This dialog box allows you to select from the following 
options: 

In the case of an unattended or service-based I/O Server, it is important not to 
leave the License Utility's Floppy License option set to drive A or B if there is 
no license diskette in the drive, as the I/O Server will not start up until the user 
appropriately acknowledges the "Abort, Retry or Ignore?" dialog box.

Button Consequences
Abort The I/O Sever will use the license on the hard drive.
Retry The "Abort, Retry or Ignore?" dialog box will reappear.
Ignore The I/O Server will run in demonstration mode.
License Utility Guide
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